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Specifications

o Product Name: T-Display-S3-AMOLED 1.43
« Release Date: 2024.12
« Version: V1.0

Introduction

T-Display-S3-AMOLED 1.43

T-Display-S3-AMOLED 1.43 is a development board. It can work independently. It consists of an ESP32-S3 MCU
that supports Wi-Fi + BLE communication protocol and a motherboard PCB. The screen is 1.43 inch AMOLED. At
the core of this module is the ESP32-S3-R8 chip. ESP32-S3 integrates Wi-Fi (2.4 GHz band) and Bluetooth 5.0
solutions on a single chip, dual high-performance cores, and many other versatile peripherals. Powered by 40 nm
technology, ESP32-S3 provides a robust, highly integrated platform to meet the continuous demands for efficient
power usage, compact design, security, high performance, and reliability. Xinyuan provides the basic hardware
and software resources that empower application developers to build their ideas around the ESP32-S3 series
hardware. The software development framework supplied by Xinyuan is intended for rapidly developing Internet
(loT) applications, with Wi-Fi, Bluetooth, flexible power management, and other advanced system features. The T-
Display-S3 AMOLED 1.43 manufacturer is Xin Yuan Electronic Technology Co., Ltd.

Arduino

A set of cross-platform applications written in Java. The Arduino Software IDE is derived from the Processing
programming language and the integrated development environment of the Wiring program. Users can develop
applications in Windows/Linux/ MacOS based on Arduino. It is recommended to use Windows 10. Windows OS
has been used as an example in this document for illustration purposes.

Preparation
To develop applications for ESP32-S3 you need:

PC loaded with either Windows, Linux,x, or Mac operating system

Toolchain to build the Application for ESP32-S3

« Arduino essentially contains API for ESP32-S3 and scripts to operate the Toolchain
« The ESP32-S3 board itself and a USB cable to connect it to the PC



Get Started

Download the Arduino Software

The quickest how to install the Arduino Software (IDE) on Windows machines

Quick Start Guide
The website provides a quick-start tutorial

« Windows:

https://www.arduino.cc/en/Guide/Windows

o Linux:
https://www.arduino.cc/en/Guide/Linux
« Mac OS X:

https://www.arduino.cc/en/Guide/MacOSX

Installation steps for Windows platform Arduino

+olv]-}

Genuino

ARDUINO

Home Buy Download Products -~ Learning -~ Forum Support ~

DOWNLOAD

Download the Arduino Software

ARDUINO 1.8.1

The open-source Arduing Software (IDE) makes it easy to

write code and upload it to the board. It runs on
Windows, Mac 05 X, and Linux. The envisoament is
written in |ava and based on Processing and other open-
source software.

This softwane can be used with any Arduing board.
Refer to the Getting Started page for Installation
instructions

Connecr, Collaborate, Create. Learn more about the Create platform.

LOG IN SIGH UP

Windows installer
Windows 2P file for non admin install

Windows app -1 2
Mac OS5 X 10.7 Lion or newer
Limux 32 bits

Linux 64 bits

Limuo ARst

Release Notes
Source Code
Checlsums (shaS12)

Try out the new
Arduino Web Editor

Enter the download interface and select Windows installer to install directly.

Install the Arduino Software


https://www.arduino.cc/en/Guide/Windows
https://www.arduino.cc/en/Guide/Linux
https://www.arduino.cc/en/Guide/MacOSX

ool

Check the components you want to install and unchedk the components
o you don't want to install, Click Next to continue,

Select components to install: E Install Arduino software

[V Install USB driver

[V Create Start Menu shortcut
[V] Create Desktop shortcut
[V] Assodiate .ino files

Space required: 392. 7MB

Arduino Setup: Installing

Extract: c++.exe
(c 0]

Mullsoft Install System v2.46

Wait for installation
Configure

Download Git
Download the installation package Git.exe


http://git.exe

-
®glt distributed-even-if-vour-workflow-isnt Q, Search entire site

About
Documentation Do'“'rnloadg
Downloads Latest source Release
GUT Clients
Lages ‘ Mac 05 X ﬂ Windows _2.21":_.
(20
Community { Linux/Unix

eleases are available and the Git source
ary is on GitHub.

The entire Pro Git book
w cott Chacon and

GUI Clients Logos
it eomes with built-in GUT tools (git-gud, Various Git loges in PNG (bitmap) and EPS
gitk), but there are several third-party toals for (vector) formats are available for use in
users looking for a platform-specific onfine and print projects.
Experience.

View Logos —

View GUI Clients —

Git via Git

1f you already have Git installed, you can get the latest development version via Git itself:

You can also always browse the current contents of the git repository using the web interface.

Pre-build configuration
Click the Arduino icon, then right-click and select “Open folder where “

« Select hardware ->
« Mouse ** Right click ** ->
« Click Git Bash Here

Cloning a remote repository
o $ mkdir espressif
« $ cd espressif

« §$ git clone —recursive https://github.com/espressif/arduino-esp32.git esp32

Connect

You are almost there. To be able to proceed further, connect the ESP32-S3 board to the PC, check under what
serial port the board is visible, and verify if serial communication works.

1. Connect the USB



2. The screen displays “E-Label” for 5 seconds.

FCCID: 2ASYE-TDISS3-AMOLED

Ew211-250112
MOOEL:T-Display-S3-AMOLED 1.43

AMOLED 1.43

Test Demo

MODEL:T-Display-53-AMOLED 1.75

Select File>>Example>>WiFi>>WiFiScan

File| Edit Sketch Tools Help

New Cirl+N
Opern... Corl+ O

Open Recent ¥
Sketchbook »
Examples |
Close Chel+W

Save Ctrl+5

Save As... Ctrl+Shift+5

Page Setup  Cirl+ Shift+ P
Print Chrl+P

Preferences  Ctrl+Comma

Cluit Crla

Upload Sketch

Select Board

SRl

SPIFFS

Ticker

Updats
WebSerer

WiF
WiFiChentSecure

Examples from Custom Libraries
Accelerometer ADXL345
ACROBOTIC 5501306
ACET12 Current Sensor
ADG850-master

Adafruit ADXL345

Adafruit APDSS960 Library
Adafruit BMEZBO Library
Adafruit BMPDBS Library
Adafruit BMP2BO Library
Adafruit DotStar

Adafruit DotStarlMatrix
Adafruit EPD

Adafruit 119341

Adafruit ImageReader Library
Adafruit INA21G

Adafruit MLE90614 Library
Adafruit MPL3115A2 Library
Adafruit MPR121

Adafruit NeoPixel

Tools -> Board -> ESP32S3 Dev Module

CEFE 2

FCC ID: 2ASYE-TDISS3-AMOLED

AMOLED 1.75

CEFC E

FCC ID: 2ASYE-TDISS3-AMOLED

Erz11-250112

MODEL:T-Display-53-AMOLED
1.75 hemispherical

AMOLED 1.75 hemispherical

ETH_LANST 20
ETH_LANST20 internal_clock
ETH_TLK11D
SimpleWiFiserver
WiRAccessPaint
\WiRBlueToothSwitch
WWiFClient
WiRiClientBasic
WiFiCliemEnterprise
WiRClientEvents
WiRClientStaticlP
iR PvG

WiFiMulti

WiFScan
WiRSmantConfig
WikiTelnetToSerial
WERUDPClient

Wes



Upload
Sketch -> Upload

Serial Monitor
Tools ->Serial Monitor

& comd = o X
Send

Scan atart

scan done

2 networks found

1: MEO-620B4B (-39)*

2: MEO-WiFi (-39)

scan start

scan done

2 networks found

1: MEO-620B4B (-38)*

2: MEO-WiFi (-38)

< » .

£ Autoscrol BothML&CR 115200 baud

SSC Command Reference

Here are some common Wi-Fi commands for you to test the module.

op
Description
op commands are used to set and query the Wi-Fi mode of the system.

Example

« op-Q
e 0p -S -0 wmode

Parameter
op Command Parameter



Parameter Description

-Q Query Wi-Fi mode.

-S Set Wi-Fi mode.

There are 3 Wi-Fi modes:

« mode = 1: STA mode

wmode * mode = 2: AP mode
 mode = 3: STA+AP mode
sta
Description

sta commands are used to scan the STA network interface, connect or disconnect AP, and query the connecting
status of the STA network interface.

Example

sta -S [-s ssid] [-b bssid] [-n channel] [-h]
« sta-Q
sta -C [-s ssid] [-p password]

« sta-D

Parameter
sta Command Parameter

Parameter Description
-S scan Scan Access Points.
-s sid Scan or connect Access Points with the SSID.
-b bssid Scan the Access Points with the bid.
-n channel Scan the channel.
-h Show scan results with hidden ssid Access Points.
-Q Show STA connect stutus.
-D Disconnected with current Access Points.
ap
Description

ap commands are used to set the parameter of AP network interface.

Example

e ap -S [-s ssid] [-p password] [-t encrypt] [-n channel] [-h] [-m max_sta]
« ap-Q
« ap—-L



Parameter
ap Command Parameter

Parameter Description
-S Set AP mode.
-s sid Set AP SSID.
-p password Set AP password.
-t encrypt Set AP encrypt mode.
-h Hide ssid.
-m max_sta Set AP max connections.
-Q Show AP parameters.
L Show the MAC Address and IP Address of the connected statio
n.
mac
Description

mac commands are used to query the MAC address of the network interface.

Example

« mac -Q [-0 mode]

Parameter
mac Command Parameter

Parameter Description
-Q Show MAC address.
* mode = 1: MAC address in STA mode.
"0 mode + mode = 2: MAC address in AP mode.
dhcp
Description

dhcp commands are used to enable or disable the dhcp server/client.

Example

« dchp -S [-0 mode]
« dhcp -E [-o mode]
« dhcp -Q [-0 mode]




Parameter
dhcp Command Parameter

Parameter Description
-S Start DHCP (Client/Server).
-E End DHCP (Client/Server).
-Q show DHCP status.
» mode = 1 : DHCP client of STA interface.
-0 mode * mode = 2 : DHCP server of AP interface.
* mode = 3: both.
ip
Description

IP commands are used to set and query the IP address of the network interface.

Example

« ip -Q [-0 mode]

« ip -S [-i ip] [-0 mode] [-m mask] [-g gateway]

Parameter
ip Command Parameter

Parameter Description
-Q Show IP address.
+ mode =1 : IP address of interface STA.
-0 mode * mode = 2 : IP address of interface AP.
+ mode = 3: both
-S Set IP address.
-iip IP address.
-m mask Subnet address mask.
-g gateway Default gateway.
reboot
Description

reboot command is used to reboot the board.

Example

« reboot




ram
ram command is used to query the size of the remaining heap in the system.

Example

e ram

FCC Caution:

Any Changes or modifications not expressly approved by the party responsible for compliance could void the
user’s authority to operate the equipment. This device complies with part 15 of the FCC Rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference, and

2. this device must accept any interference received, including interference that may cause undesired operation.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

IMPORTANT NOTE:

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, under part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used by the instructions, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

« Reorient or relocate the receiving antenna.

Increase the separation between the equipment and the receiver.

Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment t.T
equipment should be installed and operated with a minimum distance of 20 cm between the radiator& your body.

FAQs

Q: What is the purpose of the T-Display-S3-AMOLED 1.43?

A: The T-Display-S3-AMOLED 1.43 is a hardware platform for developing applications using Arduino.

Q: How do | flash firmware to the ESP32-S3 module?

A: You can flash firmware to the ESP32-S3 module by following the steps outlined in section 6 of this user
guide.



Q: What are some common SSC commands used with this product?

A: Common SSC commands include 'op', 'sta’, 'ap’, 'mac’, DHCPp', 'ip', and 'reboot'. Refer to section 7 for
more details on these commands.

Documents / Resources

T-Display-S3-AMOLED 1.43
User Guide

o LILYGO T-Display-S3-AMOLED 1.43 ESP32-S3 Module [pdf] User Guide
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AMOLED 1.43 ESP32-S3 Module, T-Display-S3-AMOLED 1.43, ESP32-S3 Module, Module
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